Copyright © 2003–2004 ESRI.

All Rights Reserved.

Printed in the United States of America.

The information contained in this document is the exclusive property of ESRI. This work is protected under United States copyright law and the copyright laws of the given countries of origin and applicable international laws, treaties, and/or conventions. No part of this work may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying or recording, or by any information storage or retrieval system, except as expressly permitted in writing by ESRI. All requests should be sent to Attention: Contracts Manager, ESRI, 380 New York Street, Redlands, CA 92373-8100, USA.

The information contained in this document is subject to change without notice.

CONTRIBUTING WRITERS
Mark Bockenhauer and Kristin Clark

U.S. GOVERNMENT RESTRICTED/LIMITED RIGHTS

Any software, documentation, and/or data delivered hereunder is subject to the terms of the License Agreement. In no event shall the U.S. Government acquire greater than RESTRICTED/LIMITED RIGHTS. At a minimum, use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth in FAR §52.227-14 Alternates I, II, and III (JUN 1987); FAR §52.227-19 (JUN 1987) and/or FAR §12.211/12.212 (Commercial Technical Data/Computer Software); and DFARS §252.227-7015 (NOV 1995) (Technical Data) and/or DFARS §227.7202 (Computer Software), as applicable. Contractor/Manufacturer is ESRI, 380 New York Street, Redlands, CA 92373-8100, USA.

ESRI, the ESRI globe logo, ArcReader, ArcGIS, the ArcGIS logo, GIS by ESRI, ArcMap, Geography Network, ArcCatalog, ArcSDE, ArcIMS, Spatial Database Engine, SDE, www.geographynetwork.com, and www.esri.com are trademarks, registered trademarks, or service marks of ESRI in the United States, the European Community, or certain other jurisdictions.

Other companies and products mentioned herein are trademarks or registered trademarks of their respective trademark owners.
1 Welcome to ArcGIS Publisher  1
   Sharing information  2
   Viewing maps  3
   Exploring data  4
   Printing maps  5
   Publishing maps with ArcGIS Publisher  6
   Tips on learning ArcGIS Publisher  7

2 Quick-start tutorial  9
   Exercise 1: Publishing a map  10
   Exercise 2: Customizing ArcGIS Publisher settings  13
   Exercise 3: Using ArcGIS Publisher security settings  18
   Exercise 4: Creating a data package  19

3 ArcGIS Publisher basics  23
   Starting ArcGIS Publisher  24
   Preparing maps for publishing in ArcMap  25
   Creating a map to share on a computer network  26
   Creating a map to distribute with data  28
   Creating a map with Internet data  30
   Using Publisher settings  31
   The Map Contents Summary dialog box  38
   Sharing your maps  39
   The data packager  40
   Creating a data package  41
   Choosing a data format for the data package  43
   Controlling the amount of data that is packaged  44

Glossary  47

Index  51
Welcome to ArcGIS Publisher

IN THIS CHAPTER

• Sharing information
• Viewing maps
• Exploring data
• Publishing maps with ArcGIS Publisher
• Tips on learning ArcGIS Publisher

Welcome to ESRI® ArcGIS® Publisher extension—a tool for publishing maps designed in ArcMap™. Have you ever wanted to share an ArcMap map document with others, only to find out that those you want to share the map with do not have ArcMap? ArcGIS Publisher can solve this problem by allowing you to publish and share maps with other people, even if they don’t have ArcMap. ArcGIS Publisher provides an environment for sharing and distributing maps. ArcGIS Publisher converts ArcMap map documents into the published map file (.pmf) format. These published maps can then be shared with other users who have the free ArcReader™ software.

This book shows you how to use ArcGIS Publisher to publish maps so that you can share your maps with other organizations or within your own organization. This chapter provides an introduction to ArcGIS Publisher. Refer to Chapter 2, ‘Quick-start tutorial’, to gain a quick understanding of how to use ArcGIS Publisher. Chapter 3, ‘ArcGIS Publisher basics’, outlines how to use ArcGIS Publisher.
Sharing information

Publishing maps allows you to share your geographic information with other users as you see it in ArcMap.

Examples of maps created in ArcMap, published with ArcGIS Publisher.
Viewing maps

Sometimes just looking at a map will tell you what you want to know. Well-designed maps not only tell you where things are but also what’s special about them. ArcGIS Publisher enables you to publish maps as they appear in ArcMap, with the same high-end cartographic symbols and map elements geographic information system (GIS) professionals are accustomed to.

*Being able to share well-designed maps, such as these, greatly increases the maps’ value.*
Exploring data

Maps are not static displays; they’re interactive. You can browse a map—taking a closer look at a particular area—and point at features to find out more about them.

You can identify features to see their attributes.
Printing maps

Use ArcGIS Publisher to publish maps and then use ArcReader to print the maps as you see them. You can choose to print the full layout as it was published or zoom to a location and just print that portion of the map.

These maps can all be printed once they are opened in ArcReader.
Publishing maps with ArcGIS Publisher

You can publish any ArcMap map document with ArcGIS Publisher. All of the map elements and symbology are saved, along with references to the data, in a .pmf file. Maps based on file, server, and Internet data can all be published. You can even deliver the data with the published map. For more information about ArcGIS Publisher, see Chapter 2, ‘Quick-start tutorial’, and Chapter 3, ‘ArcGIS Publisher basics’.

Example of a map being published in ArcMap
Tips on learning ArcGIS Publisher

If you’re new to GIS and maps, remember that you don’t have to learn everything about ArcGIS Publisher to get immediate results. Begin learning ArcGIS Publisher by working through Chapter 2, ‘Quick-start tutorial’. This chapter shows you how quickly and easily ArcGIS Publisher lets you explore a map and obtain valuable information from it. You can also read the tutorial without using your computer.

This book provides information about ArcGIS Publisher. After going through Chapter 2, ‘Quick-start tutorial’, you can quickly learn the basics of using the ArcGIS Publisher extension by working through the exercises.

Finding answers to questions

Like most people, your goal is to complete your tasks while investing a minimum amount of time and effort on learning how to use software. You want intuitive, easy-to-use software that gives you immediate results without having to read pages of documentation. However, when you do have a question, you want the answer quickly so you can complete your task. That’s what this book is all about—getting you the answers you need when you need them.

Getting help on your computer

In addition to this book, the ArcMap and ArcGIS Publisher online Help systems are valuable resources for learning how to use the software. To learn how to get help for your questions, see Chapter 3, ‘ArcGIS Publisher basics’.

Contacting ESRI

If you need to contact ESRI for technical support, refer to ‘Contacting Technical Support’ in the ‘Getting more help’ section of the ArcGIS Desktop Help system. You can also visit ESRI on the Web at www.esri.com and support.esri.com for more information on ArcGIS Publisher.

ESRI education solutions

ESRI provides educational opportunities related to geographic information science, GIS applications, and technology. You can choose among instructor-led courses, Web-based courses, and self-study workbooks to find education solutions that fit your learning style. For more information, go to www.esri.com/education.
IN THIS CHAPTER

• Exercise 1: Publishing a map
• Exercise 2: Customizing ArcGIS Publisher settings
• Exercise 3: Using ArcGIS Publisher security settings
• Exercise 4: Creating a data package

The best way to learn ArcGIS Publisher is to try it yourself. This tutorial guides you through the process of converting your ArcMap map document into a published map.

Exercise 1 shows you how to publish a map as well as how to get help with Publisher.

Exercise 2 walks you through different ways that you can publish a map. For example, you can decide what functionality is included with your map or specify whether the published map can be viewed in Data view, Layout view, or both.

Exercise 3 shows you how to publish a map that’s password protected.

Exercise 4 teaches you how to create a data package for a published map.

Each exercise in this tutorial takes about 10–15 minutes to complete. You have the option of working through the entire tutorial at once or completing each exercise one at a time.

Before you begin, install Publisher and the ArcReader tutorial data. To install the data, run the Tutorial setup during the ArcGIS Desktop installation or independently. For more information on how to install tutorial data, look at the ArcGIS Desktop installation guide for your platform.
Exercise 1: Publishing a map

Choosing a map to publish
This exercise uses the Gulf of St. Lawrence.mxd file located in the ArcReader tutorial data. However, it is possible to do this exercise with any map document.
1. Click Start, point to Programs, point to ArcGIS, then click ArcMap.
2. Open the Gulf of St. Lawrence.mxd file (located in the \ArcTutor\ArcReader and Publisher folder).

Enabling and loading the Publisher toolbar
1. Click the Tools menu and click Extensions.
2. Check Publisher in the Extensions dialog box.
3. Click Close.

4. Click View, point to Toolbars, and click Publisher.

The Publisher toolbar appears.
Using context-sensitive help to get more information about Publisher

Context-sensitive help provides information about parts of the application interface. Click the Help button or press Shift+F1 while pointing to the command you would like more information about.

1. Click the Publisher menu and click Settings.
2. Click the Help button (the small question mark next to the Close button).
3. Click the option, button, or command you want more information about.
4. Click Cancel.

Publishing a map using the default settings

1. Click Publisher and click Publish Map.

2. Use the file browser to name and select the output location for the published map.
3. Click Save.
You have just published a map.
Viewing the map in ArcReader

Please note that ArcReader is installed with a complete installation of ArcGIS Desktop. If you did not choose to add ArcReader during the initial installation, it can be added later. Please refer to the ArcGIS Desktop installation guide located in the Documentation folder on the CD.

After you have published a map, it’s a good idea to open it in ArcReader to ensure that the map is published as expected.

1. Click Start, point to Programs, point to ArcGIS, then click ArcReader.
2. Click File and click Open.
   The Select Published Map Document dialog box appears.
3. Navigate to the directory where the map was saved.
4. Double-click to open your published map.

In this exercise, you learned how to set up a map to publish using ArcGIS Publisher. In the next exercise, you will learn how you can customize ArcGIS Publisher settings in order to publish your map exactly the way you want it.
Exercise 2: Customizing ArcGIS Publisher settings

Publisher lets you adjust the settings of your map when you publish it. Having control over the way your map is published serves a variety of purposes from making it easier for ArcReader users to interact with a complex map to protecting sensitive data. Selecting the proper settings can help make the map more useful for its intended audience.

Publishing a map in Data view only

1. Click the Publisher menu and click Settings.

2. Click the Contents tab and click the Data view only button.

3. Click OK.

4. Click the Publisher menu and click Publish Map.
5. Choose an output location for the map and click Save.
If you try to save the map with the same name as a map that you have previously published, you will be asked if you want to overwrite the map. Click No and give the map a new name.

After you have saved the map, open it in ArcReader to ensure that it was published with only Data view enabled.

The graphic on the following page illustrates what your map should look like in ArcReader once you have published it with only Data view enabled.
When the map is opened in ArcReader, a message displays that alerts the map user to disabled functionality.

The Layout view button is disabled.

This is an example of a map published with only Data view enabled.
Publishing a map without a table of contents

Sometimes you may need to publish maps with reduced functionality to protect data or to meet special needs of your audience. Publisher lets you publish maps with reduced functionality, allowing you to tailor the ArcReader experience for a particular purpose. The following steps demonstrate how to turn the table of contents off. You can follow the same steps to reduce other functionality in your map, depending on your needs.

1. Click the Publisher menu and click Settings.

2. Click the Functionality tab.

3. Uncheck View Table of Contents.

4. Click OK.
5. Click Publisher, click Publish Map, and save the map to an output location.

6. Open ArcReader and navigate to the directory where you saved your map.

The table of contents does not appear.

The message notifies the user that some commands or tools have been disabled.

In this exercise, you saw how to publish a map without a table of contents. In the following exercise, you will learn how to use the security settings in Publisher to control who can access the data in your published map.
Exercise 3: Using ArcGIS Publisher security settings

There may be times when you want to control who can access your published map or the data in the map. In cases like this, you can publish your map so a password is required to open it in ArcReader. Publisher honors data source passwords and allows you to add another layer of security by password-protecting a published map.

Publishing a map that is password protected

1. Click the Publisher menu and click Settings.

2. Click the Security tab.

3. Check the Password protect the published map check box.

4. Enter a password and confirm the password.

5. Click OK.

6. Click Publish Map and save the map to an output location.

7. Reopen ArcReader. You are now prompted to enter a password before the map displays.
Exercise 4: Creating a data package

You may want to share your published map with someone who does not have access to your data. Creating a data package for your published map allows you to easily distribute the map and data. This exercise shows you how to create a published map and data package for a specific bookmark in a map document. Only the data necessary to view the bookmark will be placed in the data package.

Choosing a map to publish and package

This exercise uses the Gulf of St. Lawrence.mxd file located in the ArcReader tutorial data. However, it is possible to do this exercise with any map document.

1. Click Start, point to Programs, point to ArcGIS, then click ArcMap.
2. Open the Gulf of St. Lawrence.mxd file (located in the \ArcTutor\ArcReader and Publisher folder).

Publishing a specific bookmark

1. Click View, point to Bookmarks, then click Prince Edward Island.

2. Click Publisher and click Publish Map.
3. Choose an output location for the map, enter Prince Edward Island for the filename, and click Save.

When the Prince Edward Island.pmf is opened in ArcReader the Prince Edward Island extent will draw as it did in ArcMap.
Creating a data package for a published map

Data packages can be created in ArcCatalog or ArcMap. In ArcCatalog, right-click on a published map and click Create Data Package. In ArcMap, click the Create Data Package button on the Publisher toolbar. This exercise will use ArcCatalog to create the data package.

1. Click Start, point to Programs, point to ArcGIS, then click ArcCatalog.

2. On your computer, create a new folder named “PEI Package.” The data package will be placed in this folder.

3. Navigate to the output location for Prince Edward Island.pmf, right-click the published map, and click Create Data Package.

Choose the package location

1. Click the Package tab, then click the Browse button.

2. Browse to the PEI Package folder you created in step 2 of the previous task, and click OK.
**Setting up packaging options for vector data in the map**

When creating a data package, you can choose the output data format as well as whether to include all or a portion of the data used in the map. For this data package you will package shapefile data that intersects the extent of the data frame.

1. Click the Vector tab.
2. Click Data format dropdown menu and select Shapefile.
3. Click Include features that intersect the data frame(s).
4. Click OK, to create the data package.

If you navigate to the PEI Package folder in ArcCatalog you will see the data and published map. You can now distribute the PEI Package folder to any ArcReader user who wants to view your map.
In this tutorial, you have been introduced to some functions of ArcGIS Publisher. You learned how to change the Publisher settings to publish a map that effectively conveys the information that you want. You also saw how to view your published map in ArcReader and how to package your published map. For more information on Publisher, refer to the ArcGIS Desktop Help system. To get information about specific dialog boxes, options, or commands, use the context-sensitive help.
ArcGIS Publisher basics

IN THIS CHAPTER

• Starting ArcGIS Publisher
• Preparing maps for publishing in ArcMap
• Creating a map to share on a computer network
• Creating a map to distribute with data
• Creating a map with Internet data
• Using Publisher settings
• The Map Contents Summary dialog box
• Sharing your maps
• Creating a data package

ArcGIS Publisher is an optional extension you can install on ArcGIS Desktop. Publisher allows you to save maps for distribution and sharing with others. Publisher converts ArcMap map documents (.mxd) into the published map format (.pmf) used with ArcReader. This chapter describes the basics of using Publisher, such as how to prepare maps for publishing, how to control what functionality the map is published with, and how to share maps.

A quick-start ArcGIS Publisher tutorial follows this chapter; it will help you quickly learn how to use Publisher. It shows you how to publish a map, customize Publisher settings, and create a data package for the published map. Completing the tutorial is a fast way to learn some of what the ArcGIS Publisher extension has to offer, and it is a good way to learn how to effectively use Publisher.
Starting ArcGIS Publisher

ArcGIS Publisher is an extension to ArcMap. You must enable and add the Publisher toolbar to ArcMap to work with ArcGIS Publisher. Any .mxd file can be converted to a published map file using ArcGIS Publisher.

**Tip**

**Why is the Publisher toolbar unavailable?**

The Publisher toolbar may be unavailable for several reasons. Remember that the Publisher toolbar must be turned on in the extension manager. You also need an ArcGIS Publisher license to use ArcGIS Publisher.

Enabling and adding the Publisher toolbar

1. Click the Tools menu in ArcMap and click Extensions.
2. Check Publisher in the Extensions dialog box.
3. Click Close.
4. Click the View menu, point to Toolbars, and click Publisher.
   The Publisher toolbar will be added to ArcMap.

---

The Publisher toolbar is added to ArcMap.
Preparing maps for publishing in ArcMap

When publishing a map it is important to consider the purpose of the map and how the map will be used in ArcReader. It is also important to recognize what is in the map and how ArcMap settings, as well as Publisher settings, will affect how the output is displayed.

Accessing data

ArcReader references data sources in the same manner that ArcMap does. The data source information in the map document is also stored in the published map. Because ArcReader will be using the same method of connecting to the data, it is important to ensure that the ArcReader user will have access to the data.

In ArcMap, use the Map Properties dialog box and the Source tab on the Layer Properties dialog box to set data sources. You can also click the Source tab on the table of contents to get a quick look at the current data source connections for a map.

You need to choose the right data source connection method for your published map. What connection method you use depends on how the map will be used. For a map that is going to be distributed on a computer network, you should create the map with universal naming convention (UNC) data paths or network server-based data. If you plan to deliver the data with the published map (perhaps putting everything on digital media, such as a CD), you should use relative paths to connect to the data. You may also want to consider using Internet-served data. If you do this, anyone with a Geography Network™ connection will be able to use the map in ArcReader. You can also create a data package for the map. This is done with the Create Data Package button on the Publisher toolbar. The published map and all of the data necessary to display it in ArcReader are placed in a directory that can be easily distributed to ArcReader users. However, there are situations where you will need to package data manually. See Desktop Help for more information on these situations.

Delivering data with the map

The graphic above shows a directory structure in ArcCatalog™. The Gulf of St. Lawrence.pmf file references C:\ArcReader and Publisher\Data\Coasts.shp data. If you were to distribute data with the published map, you would create the map using relative paths. In this case the path would be ...\Data\Coasts.shp for the data in the map. ArcMap will not show the path in this manner, but if you choose Store relative path names, this is the path that will be stored in the map. As long as the published map stays relative to the data, the map layers will be accessible in ArcReader. If you were to put the map and data on a CD, you would place the Data directory and everything in it on disk.

The following tasks demonstrate how to store data source information in a map for sharing on a network.
Creating a map to share on a computer network

If you are using ArcSDE® or Internet-served data, the published map will work for all ArcReader users who have access to the servers. For file-based data you will need to create maps that store the location of the data on the network. If you click a drive letter when you add data from your computer, a local path to the data will be stored in the map. To make the map usable on another computer, you will want to store the UNC pathname in the map.

Converting local drive paths to UNC paths

1. Open ArcMap, click the Add Data button, then click the Add button to add data from a local drive.
2. Right-click the layer in the table of contents and click Properties.
3. Click the Source tab and click Set Data Source in the Layer Properties dialog box. ▶

Notice the current data source is local.
4. Click the Connect To Folder button.

5. Double-click Network Neighborhood on the Connect to Folder dialog box, browse to the directory on the computer that contains the data, then click OK.

6. Click Add in the Data Source dialog box to close it and get back to the Layer Properties dialog box.

In the Layer Properties dialog box, you will now see that the UNC pathname is stored in the map.

The UNC pathname will be published in the map, and all computers on the network with access to the directory will be able to use the map in ArcReader.
Creating a map to distribute with data

If you plan to distribute data with the map, you need to use relative paths when you create the map. When using relative paths, the map will be able to access the data as long as it stays in the same location relative to the data.

Creating a map with relative path data

1. Open Windows Explorer and put all of the data that will be used to create the map into the same folder.
2. Click the Add Data button and add your data to the map.

Tip

Create a data package for your maps

The Create Data Package button on the Publisher toolbar can be used to create a data package. A data package is a directory that contains the published map and all of the data necessary to use the map in ArcReader.
3. Click the File menu and click Map Properties.
4. Click Data Source Options on the Map Properties dialog box.
5. Click Store relative path names in the Data Source Options dialog box, then click OK.
6. Click OK in the Properties dialog box.
7. Click the Publisher menu and click Publish Map.
8. Publish or save the map in a directory that has the same parent directory as the data in the map. The data in the map will be referenced correctly as long as the map and data stay in the same relative location to one another. Send the whole directory to anyone who will be using the map.
Creating a map with Internet data

There is nothing complex about publishing Internet data. On the publishing side you only need to add data from the Internet. The user of the published map will need an Internet connection to see the data in the map.

Tip

ArcReader can open maps from the Geography Network

Published maps can be placed on the Geography Network and opened by any ArcReader user. For more information on sharing maps on the Internet, go to www.geographynetwork.com.

Creating a map with Internet data

1. Click the File menu, point to Add Data from Internet, and click Geography Network.
2. Search for Geography Network data and add it to ArcMap.
3. Click the Publish Map button on the Publisher menu bar and enter the output location.

The published map can be sent to and used by anyone who has ArcReader and a Geography Network connection.
Using Publisher settings

Publishing a map allows it to be used in ArcReader. By default, what you see in ArcMap is what you will see in ArcReader. However, there are some options available that allow you to control how the map will be viewed and used in ArcReader. Using Publisher, you can restrict the view to a specific data frame, limit the use of some commands, or even specify a password to protect the map. The settings are designed to give the map author control over how the map is viewed and how the data is explored. The following tasks show you how to publish a map with different options or restricted functionality.

Publishing a map with default settings

1. Open a map document in ArcMap.
2. Click the Publisher menu.
3. Click Publish Map.
4. Choose the output location for your published map and click Save.

A published map will be created that will look the same in ArcReader as it does in ArcMap.
Publishing a map with just the visible layers

1. Click the Publisher menu and click Settings.
2. Click the Contents tab in the Publisher settings dialog box and click Only include layers that are checked on in the Table of Contents. This setting allows you to choose specific layers for publishing in a map without removing the layers from the map.
3. Click OK.
4. Click the Publisher menu and click Publish Map.

Publishing a map with just the Data view enabled

1. Click the Publisher menu and click Settings.
2. Click the Contents tab in the Publisher Settings dialog box and click Data view only. Only the data frames will be viewable in ArcReader. That means the map’s page layout elements will not be included in the published map and Layout view will be unavailable.
3. If you want, you can also choose the data frame that will be visible in ArcReader.
3. Check the Restrict Data view to one data frame check box and choose a data frame from the dropdown list to publish one specific data frame. ArcReader will not be able to view the data frame in Layout view.

4. Click OK.

5. Click the Publisher menu and click Publish Map.

---

**Publishing just the Layout view**

1. Click Layout view only in the Publisher Settings dialog box.

   Only the Layout view will be available in ArcReader. It will not be possible to view the map in Data view.

2. Click OK.

3. Click the Publisher menu and click Publish Map.
Disabling ArcReader commands and tools

1. Click the Publisher menu, click Settings, then click the Functionality tab.

2. Uncheck the commands and tools in the list that will be disabled in ArcReader, then click OK.

When the map is opened, a message will appear telling the ArcReader user that some functionality has been disabled. To suppress this message, uncheck the Display disabled functionality message when this map is opened check box before publishing the map.

3. Click the Publisher menu and click Publish Map.
Protecting published maps with a password

1. Click the Publisher menu and click Settings.
2. Click the Security tab in the Publisher Settings dialog box.
3. Check the Password Protection check box.
4. Type in a password and confirm the password.
5. Click OK.

ArcReader requires the password to open the map.

Including secure-layer passwords

1. Click the Publisher menu and click Settings.
2. Click the Security tab in the Publisher Settings dialog box.
3. Check the Password Protection check box.
4. Type in a password and confirm the password.
5. Click OK.

ArcReader requires the password to open the map.

Tip

You can open published maps that contain secure layers with or without a password

By default, maps containing secure layers will prompt the ArcReader user for the password. Optionally, you can turn off password protection by including the password with the layer when the map is published.

Including secure-layer passwords

1. Click the Publisher menu and click Settings.
2. Click the Security tab in the Publisher Settings dialog box.
3. Check the Password Protection check box.
4. Type in a password and confirm the password.
5. Click OK.

ArcReader requires the password to open the map.

Including secure-layer passwords

1. Click the Publisher menu and click Settings.
2. Click the Security tab. Check Store the password within the published map.
3. Click OK.

The secure layer password will be stored in the published map.

Including secure-layer passwords

1. Click the Publisher menu and click Settings.
2. Click the Security tab. Check Store the password within the published map.
3. Click OK.

The secure layer password will be stored in the published map.

Tip

You can open published maps that contain secure layers with or without a password

By default, maps containing secure layers will prompt the ArcReader user for the password. Optionally, you can turn off password protection by including the password with the layer when the map is published.
Turn off the ability to package the published map

1. Click the Publisher menu and click Settings.
2. Click the Security tab in the Publisher Settings dialog box.
3. Uncheck Allow data packaging.
4. Click OK.
   It will not be possible to create a data package using this map.

Allow the published map to be opened in ArcMap

1. Click the Publisher menu and click Settings.
   The Publisher Settings dialog box appears.
2. Click the Application tab.
   Uncheck the Open in ArcReader only check box.
   This allows the map to be opened in a custom ArcReader application.
3. Click the ArcGIS Applications check box.
4. Click OK.
   The published map can be opened in ArcMap.
**Publishing a map with a timeout date**

1. Click the Publisher menu and click Settings.
2. Click the Other tab in the Publisher Settings dialog box.
3. Check Enable timeout.
4. Pick a timeout behavior and choose a timeout date.
5. Accept the default message or type in your own.
   ArcReader will display the message when the map is opened after the selected timeout date.
6. Click OK.

**Adding comments to publish with the map**

1. Click the Publisher menu and click Settings.
2. Click the Other tab in the Publisher Settings dialog box.
3. Type comments into the Comments text box.
4. Click OK.
   ArcReader users will be able to see the comments in the ArcReader Map Properties dialog box.
The Map Contents Summary dialog box

The Map Contents Summary dialog box contains information about publisher settings, map properties, and layer properties. You can use the information in the dialog box to determine how the map will be published. For example, if you have decided to only include visible layers in your map, only the visible layers will be listed in the Map Contents Summary information. You can also check the data source information that will be put into the published map in the Map Contents Summary dialog box.

1. Click the Publisher menu and click Map Contents Summary. The Map Contents Summary dialog box appears.

The Map Contents Summary dialog box shows you the parameters that control how the map will be published.
Sharing your maps

Once you have created your published map, you can share it with ArcReader users and serve it using ArcIMS®.

Keep in mind that you must ensure access to the data sources when you share your map. For file-based data sources, be sure your users can access the data for each layer. For multiuser database management system data, ensure your users have database access. For ArcIMS layers, ensure the server is available to your users. For more information on choosing and setting data source connections, see ‘Preparing maps for publishing in ArcMap’ in this chapter.

Tip

Adding Web sites to your map other than the Geography Network

If you have another Web site that you would like to access data from, you can do that. Click the File menu, point to Open Map from Internet, then click Add Website. Type the Web site’s URL and click OK. You can access the Web site by clicking the File menu, pointing to Open Map from Internet, then clicking the Web site you added. You can remove Web sites and rename them by clicking Manage Websites.

Opening maps shared on the Geography Network with ArcReader

1. Click the File menu in ArcReader, point to Open Map from Internet, then click Open Map from the Geography Network.
2. Search for a map and add it to ArcReader.
The data packager

Creating a data package allows you to easily distribute a completed published map and the data necessary to use the map. There are options that allow you to package the data to suit your needs, such as buffering, clipping, and formatting. You can also package multiple maps at the same time in ArcMap or ArcCatalog.

Creating a data package in ArcCatalog

The Data Packaging dialog box allows you to choose an output location for the data package. The Vector and Raster tabs have options that allow you to control the format and amount of data that is included in the data package.
Creating a data package

A data package is a single directory that contains one or many published maps and all of the data necessary to use the maps in ArcReader. A data package can be created by manually copying all of the data to a single directory and building the map in ArcMap using relative paths. Alternatively, you can also use the data packaging functionality available in the ArcGIS Publisher extension.

Create a data package for the published map

1. Click Package Data for Published Maps on the Publisher toolbar.
2. Choose one or more published maps to package.
   Select multiple maps by holding down the Shift or Ctrl key while clicking on the maps.
3. Click Open.
   This opens the Data Packaging dialog box.
4. Click the Browse button and choose an existing directory to place the data and published map(s) in.
5. Click OK.
6. Click OK on the Data Packaging dialog box to package the map and data with default settings.

Tip

Creating a folder to hold the data package

Windows 2000 and later has a Make New Folder button that allows you to create a folder for the data package during the data packaging process. This option is not available on Windows® NT and an existing folder needs to be chosen.
Removing layers that do not have data included in the package

1. Click the Package tab.
2. Check Only include map layers with features present in the data frame extent.

This will remove layers in the packaged map that do not have data in the package. This can occur when the intersect option is used on the Vector tab.

Increasing the size of the data frame for use with intersect and clip

1. Click the Package tab.
2. Adjust the percentage of the data frame to buffer.

You can increase the size of the data frame from 0 to 100 percent. This is a percentage of the data frame diagonal.
Choosing a data format for the data package

On the Data Packaging dialog box there are two tabs labeled Vector and Raster. These tabs have options that allow you to choose the packaged format for the vector and raster data in your published map.

For example, if your published map references SDE® data it needs to be converted to a file-based data type for packaging. This is done by choosing the file-based format of your choice on the Vector and Raster tabs.

Choosing a format for vector data

1. Click the Vector tab.
2. Choose Shapefile from the Data Format pulldown menu.
   All of the vector data in your map will be converted to shapefiles in the data package.

Tip

CAD data is always copied

CAD data referenced in the published map will always be copied into the data package.

Choosing a format for raster data

1. Click the Raster tab.
2. Choose ERDAS® IMAGINE® from the Data Format pulldown menu.
   All raster data in your map will be converted to ERDAS IMAGINE files.
Controlling the amount of data that is packaged

When packaging published maps for distribution to others there are several things to consider about the data. What data type is being used in the current map? How much of the data is necessary to use the map? If distributing on CD will all of the data fit?

The Data Packager provides options that will allow you to create a data package that is tailored to meet your needs.

Include only features that intersect the data frame(s) in the data package

1. Click the Vector tab.
2. Click Include Features that intersect the data frame(s).

If any portion of the feature intersects the data frame, the entire feature will be packaged.

Tip

The data is intersected or clipped as it appears in layout view

In ArcMap, if you switch between Data and Layout view, you will notice that the amount of data displayed in the data frame varies. The data packager uses the data frame as it appears in Layout view for intersecting and clipping.

Clipping rasters to the extent of the data frame(s)

1. Click the Raster tab.
2. Click Clip the raster to the data frame.

The raster will be clipped to the data frame extent.
Including all of the vector data

1. Click the Vector tab.
2. Click Include all features in the data set.
   All of the features will be packaged in the chosen format.
   or
3. Check Copy data into the package.
   All of the vector data will be copied into the package.

Tip
Copying a personal geodatabase
If the map references one specific layer in a personal geodatabase, the entire personal geodatabase is copied into the data package.

Tip
ArcSDE data cannot be copied
If Copy data into the data package setting is chosen, ArcSDE® data in the map will be converted to a Compressed and Locked format.
Including all of the raster data

1. Click the Raster tab.
2. Click Include all features in the data set.
   All of the features will be packaged in the chosen format.
   or
3. Check Copy data into the package.
   All of the raster data will be copied into the package.

Tip
Rasters can have very large file sizes
If your map references compressed raster formats, they could be too large to package when uncompressed.
active data frame
The data frame you’re currently working with—for example, the one to which you are adding layers. The active data frame is shown in bold in the table of contents.

attribute
A characteristic of a map feature. Attributes of a river might include its name, length, average depth, and so on.

attribute table
Information about features on a map, stored in rows and columns. Each row relates to a single feature, while each column contains the values for a single characteristic.

data frame
A frame on the map that displays layers occupying the same geographic area. You may have one or more data frames on your map depending on how you want to organize your data. For instance, one data frame might highlight a study area, and another might provide an overview of where the study area is.

data source
Any geographic data, such as a coverage, shapefile, raster, or geodatabase.

Data view
An all-purpose view for exploring, displaying, and querying geographic data. This view hides all map elements, such as titles, North arrows, and scalebars. See also Layout view.

display units
The units—for example, feet, miles, meters, or kilometers—ArcReader uses to report measurements, dimensions of shapes, and distance tolerances and offsets.

feature
A representation of a real-world object in a layer on a map.
**feature class**

1. A classification describing the format of geographic features and supporting data in a coverage. Coverage feature classes for representing geographic features include point, arc, node, route system, route, section, polygon, and region. One or more coverage features are used to model geographic features; for example, arcs and nodes can be used to model linear features, such as street centerlines. The tic, annotation, link, and boundary feature classes provide supporting data for coverage data management and viewing.

2. The conceptual representation of a geographic feature. When referring to geographic features, feature classes include point, line, area, and surface. In a geodatabase, an object class that stores features and has a field of type geometry.

**field**

A column in a table. Each field contains the values for a single attribute.

**geodatabase**

A geographic database that provides services for managing geographic data. A geodatabase is hosted inside a relational database management system. A geodatabase contains feature datasets.

**graticule**

A graphic representation on a map of the network of parallels and meridians (latitude and longitude) that subdivide the earth’s surface.

**grid**

A geographic representation of the world as an array of equally sized square cells arranged in rows and columns. Each grid cell is referenced by its geographic x,y location. See also raster.

**group layer**

Several layers that appear and act like a single layer in the table of contents in ArcReader.

**image**

Represents geographic features by dividing the world into discrete squares called cells. Examples include satellite and aerial photographs, scanned documents, and building photographs. See also raster.

**layer**

A collection of geographic features—such as rivers, lakes, counties, or cities—of a particular area or place for display on a map. A layer references geographic data stored in a data source, such as a coverage, and defines how to display it. You can create and manage layers as you would any other type of data in your database.

**layout**

The design or arrangement of elements—such as geographic data, North arrows, and scalebars—in a digital map display or printed map.

**Layout view**

The view for laying out your map. Layout view shows the virtual page upon which you place and arrange geographic data and map elements—such as titles, legends, and scalebars—for printing. See also Data view.

**legend**

A list of symbols appearing on the map; includes a sample of each symbol and text describing which feature each symbol represents.
map
A graphical presentation of geographic information. It contains geographic data along with other elements, such as a title, North arrow, legend, and scalebar. You can interactively display and query the geographic data on the map and also prepare a printable map by arranging the map elements around the data in a visually pleasing manner.

map display
A graphic representation of the map on the computer screen.

map document
The disk-based representation of a map. Map documents can be printed or embedded into other documents. Map documents have a .mxd file extension.

map element
A graphic component, such as a scalebar, North arrow, and title, that helps describe the geographic data on the map.

Map Tips
Displays onscreen descriptions of map features when you point to the feature.

map units
The units—for example, feet, miles, meters, or kilometers—in which the coordinates of spatial data are stored.

neatline
A border commonly drawn around geographic features, often to separate them from other map elements.

North arrow
A map element that shows how the map is oriented.

projection
A mathematical formula that transforms feature locations from the earth’s curved surface to a map’s flat surface. A projected coordinate system employs a projection to transform locations expressed as latitude and longitude values to x,y coordinates. Projections cause distortions in one or more of these spatial properties: distance, area, shape, and direction.

raster
Represents any data source that uses a grid structure to store geographic information. See also grid and image.

scale
The relationship between the dimensions of features on a map and the geographic objects they represent on the earth, commonly expressed as a fraction or a ratio. A map scale of 1/100,000 or 1:100,000 means that one unit of measure on the map equals 100,000 of the same unit on the earth.

scalebar
A map element that graphically shows a map’s scale.

shapefile
A vector data storage format for storing the location, shape, and attributes of geographic features. A shapefile is stored in a folder and contains one feature class.

symbol
A graphic representation of an individual feature or class of features that helps identify it and distinguish it from other features.

symbology
The criteria used to determine symbols for the features in a layer. A characteristic of a feature may influence the size, color, and shape of the symbol used.
table of contents
Lists all the layers on the map and shows what the features in each layer represent.
Index

A
Active data frame
defined 47
ArcGIS Publisher
customizing settings 13–17
settings 31
starting 24
using security settings 18
ArcGIS Publisher tutorial
enabling Publisher toolbar 10
loading Publisher tutorial 10
publishing a map 10–11, 19
viewing map in ArcReader 12
Attribute tables
defined 47
Attributes
defined 47

D
Data
accessing 25, 40
Data frames
active
defined 47
defined 47
Data sources
defined 47
Data view
defined 47
Display
units
defined 47

F
Feature class
defined 48
Features
defined 47
Fields
defined 48
Functionality
restricting 31

G
Geodatabase
defined 48
Getting started
with ArcGIS Publisher. See ArcGIS Publisher
tutorial
Graticules
defined 48
Grid
defined 48
Group layers
defined 48

I
Images
defined 48

L
Layers
defined 48
Layout view
defined 48
Legends
defined 48

M
Map Contents Summary dialog box 38, 41
Map display
defined 49
Map documents
defined 49
Map elements defined 49
Map Tips defined 49
Map units defined 49
Maps
  creating for computer network 26
  creating to distribute with data 28
  creating with Internet data 30
  defined 49
  preparing for publishing 25, 40
  publishing
    adjusting settings 31
    with comments 37
  sharing 39

Neatlines defined 49
North arrows defined 49

Projections defined 49
Publisher toolbar
  adding 24
  enabling 24
Publishing maps
  adjusting settings 31

Rasters defined 49

Scale defined 49
Scalebars defined 49
Shapefiles defined 49
Symbology defined 49
Symbols defined 49

Table of contents defined 50
Tables
  fields defined 48
Tutorial
  ArcGIS Publisher. See ArcGIS Publisher tutorial

Units
  display defined 47
  map defined 49